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Excel Tip # 1: Switch Between Excel Spreadsheets Only
It’s very frustrating when you have multiple applications

That’s it! It’s this simple and will save you a lot of time

open (such as Excel, PowerPoint, Word, Chrome, and IE)
and you want to switch between Excel spreadsheets only.
No matter how efficient you are, this can get on to your
nerves in a few minutes. In this tip, let me show you how

Note: While most of the people are addicted to ALT + Tab,
the drawback is that it does NOT differentiate between
different applications. So if you have 2 excel workbooks
open along with a Chrome/FireFox/IE browser window, it

to handle this.

will toggle one by one through each of these. Control +
Use Control + Tab to toggle between open

Tab will toggle between open Excel workbooks only.

spreadsheets only (keep the Control button pressed
while you press Tab button to switch)

Bonus Tip: This technique works with any Microsoft application, including Power Point and Word
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Excel Tip # 2: Quickly Make a Copy of a Worksheet
A lot of times you may need to quickly make a copy of the

How to:

worksheet in which you are working.
1. Select the worksheet tab for which you want to
Normally, one would right-click on the tab and select

make a copy.

move or copy, and then check the “Create a Copy” check

2. Press and hold the Control Key.

box. While there is nothing wrong in this, here is a faster

3. Left-click on the worksheet tab for which you

way to do this.

want to create a copy (a plus sign within a sheet
icon will appear next to the cursor).
4. While still holding the Control key and the Left
button of the mouse, drag the tab within the
worksheet.
5. Leave the mouse left-button and then leave the
Control Key.
This would create a copy of the worksheet in the
same workbook.
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Excel Tip # 3: Multiply/Divide with a number using Paste Special
Ever faced a situation when you had to convert all the

How to:

numbers into percentages or millions to billions (for
example 10,000 million to 10 billion). The long way to do

1. Let’s say you want to convert values in millions to

this is to first divide each number by 1,000 in a separate

billions. In an empty cell, type the number with

column and then copy paste the values.

which you want to divide the numbers (in this case
it would be 1000).

The faster way would be to use Paste Special options.

2. Copy the cell in which you entered 1000 (CTRL + C)
3. Select the cells in which you want to convert
millions to billions.
4. Right Click and Select Paste Special. This will open
Paste Special dialogue box (Key board shortcut – Alt
+ E + S).
5. In the Operations category select Divide.
6. Click OK.
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Excel Tip # 4: Freeze Panes to always Display Headers
While working with large data sets, it’s frustrating to come

How to:

back again to the row/column that has the headers. There
is a way you can freeze the header rows/columns.

1. Go to the View Tab.
2. Select Freeze Panes.

It’s called Freeze Panes.

3. Select Freeze Panes/Freeze Top Row/Freeze First
Column (based on what you want to freeze –
described below):
o Freeze Panes: This option freezes both rows
and columns. Select a cell and then go to
View  Freeze Panes  Freeze Panes. This
will freeze the columns to the left of the cell
and the rows above it.
o Freeze Top Row: Select the data set and
choose this option to freeze the top row in
the data set.
o Freeze First Column: Select the data set and
choose this option to freeze the first column
in the data set.
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Excel Tip # 5: STOP using Merge and Center (use Center Across
Selection instead)
A lot of people use the Merge and Center feature when

How to:

they want to combine cells and show it as one cell. While
it gets the work done, it has a few drawbacks.

1. Select the cells that you want to merge.
2. Go to Home  Alignment  Alignment Settings

For example, you can have issues while sorting or filtering

(click on the small tilted arrow in the bottom right

the data. It also causes issues when you try to select cells

of the group, or use the keyboard shortcut Control

in a column that contains merged cells.

+ 1 and the select the Alignment tab).

In all most all cases, a better alternative is the Center
Across Selection option (when merging cells in columns).

3. In the Text Alignment Horizontal dropdown, select
Center Across Selection.
4. Click Ok.
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Excel Tip # 6: Selective Clearing (format, content, comments,
hyperlinks)
Excel gives you the flexibility to selectively clear contents

How to:

from a cell. You can choose to clear contents only
(keeping the formatting intact), or clear formatting only,
while keeping the content as it is. Or you can choose to
clear everything.

1. Select the cell(s) from which you wish to clear the
contents/formatting/comments/hyperlinks.
2. Go to Home  Editing Category  Clear  Clear
(All/Formats/Contents/Comments/Hyperlinks).

Other alternatives include clearing comments or

3. Select the required option.

hyperlinks.
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Excel Tip # 7: Select and Delete all Comments at Once
If you have a large data set full of comments, and you

How to:

want to delete all the comment, there is a super quick
way to do this.

1. Select the entire worksheet (Keyboard Shortcut –
Control + A).
2. Press F5. This opens the Go To dialogue box.
3. In the Go To dialogue box, click on Special.
4. In Go To Special dialogue box, ensure that
Comments option is selected.
5. Click Ok (this would select all the cells that have
comment in it).
6. Go To Home  Editing  Clear  Clear Comments.
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Excel Tip # 8: Use Control + Enter to Fill an Entire Range
This tip can help you to speed up your work significantly. A

How to:

lot of times we have to apply the same formula for a range
of cells (see image below).

1. Select the entire data in which you wish to enter
the formula. You will notice that the first cell is

Normally, we put it in one cell and then copy and paste

lighter in color when compared to the other

the formula in all the other cells, or (if contiguous

selected cells. It’s the active cell.

rows/columns), we drag the auto fill handle to apply the
same formula for all the cells
Here is an alternative that save you a few seconds.

2. Start typing the formula (or text) that you want in
all the cells in the active cell.
3. Use Control + Enter instead of Enter (Keep Control
key pressed when you hit Enter).
You’ll see that all the selected cells have been filled with
the result of the formula.
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Excel Tip # 9: Copy Formula on Clipboard to be used Later
Often when we work with long formulas or text strings in

How to:

Excel, there is a need to copy and paste the same part of
the text or the formula again and again.

You first have to enable this feature to copy in clipboard:

There is a clipboard feature in Excel that lets you copy and

1. Go to the Home tab.

store the copied text/formula at a single place, and you

2. In the Clipboard category, click on the arrow at the

can then quickly retrieve it and paste it later.

bottom-right (shown in the pic). This will open the
clipboard on the left.
3. Click the Options button (at the bottom-left of the
pane) and select ‘Show Office Clipboard When
Ctrl+ C pressed Twice’.
4. Close the Clipboard section.
5. Now when you wish to copy the content of any cell,
get into the edit mode (by pressing F2) and select
the text (or formula).
6. With the text selected, press Control + C + C (hold
the Control key and hit ‘C’ key twice). This will
copy the text/formula in the clipboard.
7. Now if you want to paste this copied text sometime
later, go to the cell where you want to paste this,
open the clipboard pane, and double click the text
that you want to paste.
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Excel Tip # 10: Too Many Worksheets - Use the New Window
Feature
If you work with an Excel workbook where you have to

What this does:

scroll up and down in the same worksheet, or go back and
forth between worksheets, it could lead to a lot of
frustration and time-waste.

 Suppose you have a worksheet named Test.xlsx.
When you click on New Window in the View tab, it
replaces the Test.xslx spreadsheet with 2 replicas -

I will show you a simple & elegant way to deal with this:
How to:
1. Go to the View Tab.
2. Select New Window in the Windows group.

Test.xlsx:1 and Test.xlsx:2. Any changes made in
one of the workbook would be reflected in the other
one (in real time). This is quite useful when you
have multiple sheets within a workbook and need to
refer to data in multiple worksheets. For example,
you may want to see what changes in Sheet2 when
you change the values in Sheet1.
 You can choose to arrange them vertically or
horizontally to view these side by side. To do this:
o Go to View  Arrange All.
o In the Arrange Window dialogue box, select
the way you want to arrange these.
This could be particularly helpful when you need to refer
various sheets in the same workbook.
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Excel Tip # 11: Split your Worksheet to be more Efficient
Excel is made to handle large data sets, but it could get

This will split will your worksheet into 4 parts.

really frustrating if you have to scroll back and forth again
and again in the same worksheet. This neat trick will help
you to get more efficient while you work with large data
sets in Excel
How to:

Don’t worry, nothing changes.
Now you can treat each of the four panes as a separate
space and scroll up or down. This enables you to create a
formula in the 100th column while you can still see the 1st
column (or any column you wish).

1. Go to View Tab.
2. In Windows category select Split.

If you only want a vertical split, just go to the horizontal
split line and double click on it, and it will go away.
Super! Isn’t it?
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Excel Tip # 12: A Quick Way to Move Rows and Columns
This is an awesome trick. It’s one of those hidden gems

How to:

that not many people know about.
1. Select the cells in the column that you want to
This technique will help you in quickly moving data in rows
and columns, without any of the messy stuff
(cutting/pasting and inserting/deleting of rows or
columns). It’ll let you move the selected cells anywhere in
the sheet, without messing with the other rows/columns.

shift (works for contiguous selections only).
2. Press the right button of your mouse and hold
the Shift Key from your keyboard.
3. Move the cursor to the edge of the selection. It
would display the move icon (a four directional
arrow icon).

You got to try it to believe it!!

4. Click on the edge (with left mouse button) while
still holding the Shift-key.
5. Move it to the column where you want this to be
shifted
 When you bring the selection to the edge of
any column, you would see a vertical line
(something that looks like roman numeral 1
or alphabet Capital I – shown in the image on
the left)
6. Leave the mouse button at the edge of the
column where you want the data to be moved.
7. Leave the Shift-key (remember to keep the Shift
key pressed till the end).
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Excel Tip # 13: Quickly Create Named Ranges from Data
While this seems like a mere shortcut, it deserves its place

How to:

in this Excel Efficiency Tips section.
1. Arrange your data in a way where you have headings
Suppose you have the sales data in columns for 3 months

(for which you need to create a named range) in

(Jan, Feb, and Mar), and you want to create named ranges

Top/Bottom row or Top/Bottom column.

from the data for each month. Just use this shortcut –

2. Press Control + Shift + F3.

Control + Shift + F3.

3. In the dialogue box, check the option for which you
wish to create the named range. In this case, since the
months are in the top row, select Top row.
4. Click OK. That’s it!!
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Excel Tip # 14: Display a Message when a Cell is Selected
I am not talking about inserting a comment here. I am

How to:

assuming that you already know how to do it. The
drawback in a comment is that it gets displayed ONLY

1. Select the cell in which you want to display the

when you hover mouse over the cell that contains that

message on selection and go to Data tab  Data

comment (It’s sometimes irritating as well).

Validation.
2. In Data Validation dialogue box, select Input

In this trick, I will show you how display a message when a
cell is selected either by using the mouse or by the
keyboard. This could be useful for someone who creates a
report that need some inputs from the user. A message on
how or what needs to be entered could be of great help.

Message tab.
3. Ensure that “Show input message when cell is
selected” check box is selected.
4. In the Input message tab, enter Title (max 32
characters, optional) and Input Message (max 256
characters)
5. Click OK.
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Excel Tip # 15: Group and Ungroup data
A lot of times the data you work with can have categories

How to:

and sub-categories. For example, there could be a country
category (say the US), and then there could be
subcategories of its states. Similarly, there could be
multiple countries and their states.

1. Select the data that you want to group.
2. Go to Data  Group.
3. Select Group by Rows or Columns.

It might be desirable to temporarily hide the states and
only display the countries. While hiding of rows/columns
could be one way, there is a neater way to do this through
grouping the data.
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Excel Tip # 16: Select Visible Cells only
If you a dataset that has some rows/cells hidden, and you
copy the cells in this dataset, it copies the cells that are
visible as well as the cells that are hidden.
This can cause havoc if you copy it somewhere else
thinking that you are only copying the visible cells (see the
image below).
What you need is a way to copy the visible cells only. In
this tip, I’ll show you how to do this.

How to deal with this:
1. Select the data which has hidden rows/columns and
where you want to copy only the visible cells.
2. Go to Home  Find & Select  Go To (Keyboard
Control + G).
3. In the Go To dialogue box, click on Special.
4. In the Go To Special dialogue box, select Visible
cells only.
5. Click OK.
6. Now when you copy and paste, this will paste visible
cells only.

Bonus Tip: Instead of following these many steps, select the data and use the keyboard shortcut Alt + ; This would
automatically select visible cells only. Now you can simply copy these cells and paste it.
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Excel Tip # 17: Remove Blank Cells from a List
More often than not, you end up with useless blanks in the

How to:

data set that need to be eliminated. Here is a simple and
quick way to identify and select all the blank cells. Once

1. Select the entire data set.

selected, it’s up to you to deal with these (delete it, color

2. Press F5 (this will open Go To dialogue box)

it, or type something into it).

o You can also access it from Home  Find &
Select  Go To.
3. In the Go To dialogue box, select Special (this will
open the Go To Special dialogue box).
4. Select Blanks.
5. Click OK (this will select all the blank cells).
Now you can do whatever you want with these cells.
Below are some examples:
 Delete blank cells or the entire row that has the
blank cell.
 Color these cells to highlight it.
 Type some text in all of the blank cells (such as NA
or Not Available). To do this, type the text in the
active cell and press Control + Enter.
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Excel Tip # 18: Angle Cell Text to make Column’s Width Narrow
Sometimes, when you have long text in headers, it is better to format these (as shown below). These also save you some
column width, so you can view more data at once on your screen.

How to:
1. Select the headers (January, February..).
2. Go to Home  Alignment  Orientation  Angle Counterclockwise
o This will align your text at a 45o angle.
3. With the headers selected, go to Home  Font  Borders  All Borders.
a. This will give a border to the headers. You can apply border to the entire data set if you wish
4. Now you can resize your column width and you are done.

Bonus Tip: You can access all these options from Format Cells Dialogue box (Key board shortcut – Control + 1)

http://TrumpExcel.com

Excel The Smart Way (51 Tips)

24

Excel Tip # 19: Split a Cell by a Diagonal Line to get 2 Headers
This technique enables you to split a cell by a diagonal

How to:

line, so that you have 2 headers in the same cell (one each
for row and column of headers).

1. Select the cell.
2. Go to Home  Fonts  Format Cells (key board

Something as shown below:

shortcut – Control + 1)
3. Select Border tab and select the diagonal split
option at the bottom of the dialogue box.
4. Select the cell and go into the edit mode (by
pressing F2).
5. Type Months (or the heading you want to be at the
top-right).
6. Press Alt + Enter – This takes you to the next line
within the same cell.
7. Type Sales Rep (or the heading you want to be at
the bottom-left).
8. Put some spaces before the Months to push it to the
right (adjust accordingly).
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Excel Tip # 20: Snap Objects/Pictures to Cell Borders
This technique will enable you to quickly snap a

How to:

shape/picture/charts to the border of any cell in Excel.
This is helpful in situations where you need to put a
picture/shape within a cell

1. Select the shape/picture/chart that you want to
align with a cell.
2. Press Alt and move the shape/picture/chart (keep
the Alt pressed).
You will notice that the object will snap to the border of
the cell where you moved it.
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Excel Tip # 21: Highlight Alternate Rows Using Conditional
Formatting
Conditional Formatting can be a great ally in creating

How it works:

amazing spreadsheets. A trick as simple as highlighting
alternate rows could immensely increase the readability of
your data set. Here is how to do this:

The entire magic is in the formula =ISODD(ROW()).
[ROW() function returns the row number of a cell and
ISODD checks whether the row number is odd or even.]

How to:
This evaluates each cell and checks if it meets the criteria.
1. Select the data set.

Suppose the data is in A2:D10 (as shown in the pic below).

2. Open the Conditional Formatting dialogue box

So it first checks A2. Since the Row number of A2 is 2,

(Home  Conditional Formatting  New Rule)

ISODD(ROW()) would return FALSE for A2.

[Keyboard Shortcut - Alt + O + D].
3. In the dialogue box, select “Use a Formula to
determine which cells to format” dialogue box.
4. Enter the following formula =ISODD(ROW())

So it moves on to the other cell in next row. Here the row
number of A3 is 3 and ISODD(ROW()) returns TRUE, which
meets the condition. Hence, it highlights this cell.

5. Click on the Format button to set the formatting.
6. Click OK.

Read more about this here
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Excel Tip # 22: Search and Highlight Cells using Conditional
Formatting
Suppose you have a data set as shown below, with Product

How to:

Name, Sales Rep, and Geography. The idea is to type a
1. Go to Home –> Conditional Formatting -> New Rule

string in cell C2, and if it matches the data in any cell(s),

(Keyboard Shortcut – Alt + O + D).

then that cell should get highlighted.

2. In the New Formatting Rule dialogue box, select
Something as shown below:

the option Use a formula to determine which cells
to format.
3. Now enter this following formula
=AND($C$2<>””,$C$2=B5), and then click on
‘Format..’ button to set the formatting.
4. Click OK
Now type anything in cell C2 and press enter. It will
highlight the cells that contain the string you entered in
C2.
This works when the formula returns TRUE, and the
formula returns TRUE when C2 is not empty ($C$2<>””)
and exactly matches the searched string.

Read more about this here
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Excel Tip # 23: Highlighting Errors/Blanks using Conditional
Formatting
Conditional Formatting can be really helpful if you want to

How to:

identify if there are any blank cells or cells with error in
the dataset. While it’s easy to identify these cells
manually in small dataset, doing that in large datasets
could be time consuming and error prone.

Assuming that the data is in cells A2:A8
1. Go to Home  Conditional Formatting  New Rule.
2. In the New Formatting Rule dialogue box, select Use
a formula to determine which cells to format.
3. Type the formula =OR(ISBLANK(A2),ISERROR(A2))
4. Set the formatting and Click OK.
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Excel Tip # 24: Create a Simple Gantt Chart Using Conditional
Formatting
Conditional Formatting can be used to quickly create a

How to:

Gantt Chart in Excel (as shown below). All you need is the
right formula in right cells.

Suppose the start date is in Column B and end date in
Column C. Here are the steps to highlight cells (with each
cell representing a day as shown in the pic) that lie in the
specified date range.
1. Go To Home  Conditional Formatting  New Rule.
2. Select ‘Use a Formula to determine which cells to
format’ and type the following formula
 =AND((COLUMNS($D$5:D5)-1)>=($B5$B$5),(COLUMNS($D$5:D5)-1)<=($C5-$B$5))
3. Select the format and click OK.
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Excel Tip # 25: Find and Replace Partial Matches (Using
Wildcard Characters)
Wildcard characters in excel are quite versatile. You can

How to:

use it in complex formula as well as in basic functionality

1. Select the data set.

such as Find and Replace. Suppose you have a data set as

2. Press Control + H (Opens find and replace dialogue

shown below, and you want to change all the different
words (such as Excel, Excels, Excellent) to Excel.

box).
3. Enter the text that you want to find along with the
wildcard characters (Excel* in Find what: field).
4. Enter the text you want to replace this with (Excel
in Replace with: field).

Bonus Tip: You can use wildcard character at the beginning and end of your text (for example, *excel*), and it will
find and replace any text that contains the text (excel) anywhere in the cell.
You can do so much more with Wildcard Characters. Read about it here
http://TrumpExcel.com
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Excel Tip # 26: Put a comment in an Excel Formula
In this tip you’ll learn a simple method to put a comment

How to:

in your formula.
1. At the end of a formula, use N(“Your
It could be helpful if you are creating he formulas and
want to have a comment that describes what it does or the

comment”)
 For example, if I have a formula =A1+A2,

logic involved. It could also be helpful if you are sharing

you can use =A1+A2+N(“This adds cells A1

your work with others, so that they can easily decode your

and A2”).

formulas.
Logic: N() formula converts text to 0, and does
not impact the original formula.
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Excel Tip # 27: Create Custom Sorting Criteria
Sorting is one of the most frequently used features in

How to add Custom Sorting Criteria:

Excel. Some common examples include sorting
alphabetically, by value (largest to smallest or smallest to

 Go to File –> Options.

largest), by the day of the week (Mon, Tue, Wed..), or by

 In the Excel Options Dialogue Box, select Advanced

month names (Jan, Feb..)

from the list in the left pane. Within Advanced
selected, scroll down and select Edit Custom List.

While these are in-built sorting criteria, you can your own

 In the Custom Lists dialogue box, type your criteria

sorting criteria according to your data (such as High-

in the box titled List Entries. Type your criteria

Medium-Low, Good-Ok-Bad)

separated by comma (High, Medium, Low) [you can
also import your criteria if you have it listed]
 Click Add and then click OK.
How to sort you data based on Custom Criteria
 Select the data set.
 Go to Data –> Sort.
 In the Order drop-down list, select Custom List.
 Select the criteria and click OK.
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Excel Tip # 28: Enter Bullets in Excel
Here is the keyboard shortcut that will insert a bullet in a

How to:

cell in Excel. This could be helpful if you want a bulleted
list.

1. If you have a numeric keyboard:
 Go to the cell and double-click (or F2) to get
into edit mode.
 Press Alt + 7 or Alt + 9.
2. If you do not have a numeric Keyboard (as in my
laptop), activate the NumLock.
 Go to the cell and double click (or F2) to get
into edit mode.
 Press Alt + 7 or Alt + 9.
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Excel Tip # 29: Display Negatives values in Red using Number
formatting
It is a common practice to highlight the negative numbers
in red. And custom formatting can make it quick and easy.

How it Works:
The number formatting in excel is divided into four parts
(in the given order)

How to:
1. Select the data set where you want to highlight the
negatives numbers in red.
2. Open Format Cells dialogue box (Key Board Shortcut
– Control + 1).
3. Select Custom number format category.
4. In the Type field write
 0.00;[Red]-0.00;

 <POSITIVE>;<NEGATIVE>;<ZERO>;<TEXT>
You can specify the format for each of these categories
separately. In this example, 0.00;[Red]-0.00; would mean
that positive numbers would be displayed with 2 decimal
places, and negative numbers would be displayed with 2
decimal places, a negative sign, and red color.
Excel allows you to use various colors for the text in the
cell (as I have used Red here in square brackets)
Some Examples:
 0.00;[Red]-0.00; - Highlights negative numbers in
Red, with a negative sign
 0.00;[Red]0.00; - Highlights negative numbers in
Red, without a negative sign
 [Green]0.00;[Red]-0.00; - Highlight positive numbers
and zero in green and negative numbers in red
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Excel Tip # 30: Insert Picture into a Comment Box
You can easily insert an image in a comment in Excel. This

How to:

could be useful if you have a list of products and you want
to show the image in the comment. Remember, you would
have to do this manually for each comment.

1. In a worksheet, insert a comment (Keyboard
Shortcut – Shift + F2).
2. In the comment, delete any existing text (if any).
3. Right Click on the border of comment and click
‘Format Comment’.
4. Select ‘Color and Lines’ tab.
5. In the Color Drop down menu select ‘Fill Effects’.
6. In ‘Fill Effects’ dialogue box, select ‘Picture’ tab.
7. Click on ‘Select Picture’.
8. Browse and select the picture you want in the
comment and click OK.
9. That’s it!!
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Excel Tip # 31: Keep the Headers at the Top While Printing
If you have large data set and you print it, it prints the

How to:

headers in the first sheet only. Rest all the sheets do not
get the header printed.

1. Go to Page Layout  Page Setup  Print Titles (Key
Board Shortcut – Alt + PSP).

Here is a way to get headers on all the sheets while

2. In the Page Setup dialogue box, go to the Sheet Tab.

printing the data.

3. In the Sheet tab, specify the Print Area.
4. In the Rows to repeat at the top field, specify the
rows that should appear at the top of each printed
page .
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Excel Tip # 32: Enable Data Entry only when the Previous Cell is
Filled
You would have seen this in a lot of online forms. It

How to:

mandates you to first fill a particular field before you can
enter something in the next field.

1. Select cell A2.
2. Go To Data  Data Tools  Data Validation  Data

You can create the same setting in Excel as well. For
example, if A1 is empty, then the user should not be able
to enter anything in A2.

Validation.
3. In the Settings tab go to the Allow drop down and
select Custom.
4. In the Formula field, type =NOT(ISBLANK($A$1))
5. Ensure that the Ignore Blank is Unchecked.
6. Click Ok.
Now when you enter something in cell A2, and if A1 is
empty, an error will be displayed
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Excel Tip # 33: Create your Own Error Messages in Data
Validation
This is a useful trick when you have a sheet where you
seek inputs from the users. For example, you may want
them to enter a 10-digit phone number, and display an
error if they enter a number lower or higher than 10
characters.
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How to:
1. Select the cell where you want the data validation
rule
2. Go To Data  Data Tools  Data Validation  Data
Validation.
3. In the Settings tab go to the Allow drop down and
Set the Length to 10.
4. Go to Error Alert Tab.
5. Ensure Show error alert after invalid data is entered
is checked.
6. In the Style drop down, ensure Stop is selected.
7. In the Title field type - Enter a 10 Digit Number.
8. In the Error message field type - The number you
have entered does not seems right. Please enter
again.
9. That’s It!! If now you enter a number less than or
more than 10 character, it will show an error that
you scripted.
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Excel Tip # 34: Perform Multi-Level Sorting
With multi-level sorting, you can sort one column, and
then the second one in such a way that the first one is still
sorted. The pic below might make it more clear:

http://TrumpExcel.com

How to:
1. Select the entire data set.
2. Go to Data  Sort and Filter  Sort.
3. In the Sort dialogue box, Select Column Sort by, Sort
On and Order values from drop downs [for the
subject column, i.e., the first level sorting]
4. Now click on the Add Level option at the top. This
will add another sorting level
5. Again select the sort criteria [for the score column,
i.e., the second level sorting]
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Excel Tip # 35: Disguise Numbers as Text Using Custom Number
Formatting
This trick is nothing short of magic. And to add to it, this
also has a practical use in our daily work. The idea is to
have a cell where you type a particular number, but as
soon as you hit enter, it displays a predefined text.
I recently used this when I wanted to display the text
“Not Available” whenever there was a 0 in the data. The
best part is, this doesn’t change the value of that cell. So
it remains 0 and you can use it in calculation (precisely the
reason why I used the word DISGUISE!!)

How to:
1. Select the data set.
2. Press Control + 1 (this opens the Format Cells
dialogue box).
3. In the Number tab go to Custom Category.
4. Or the right panel type [=0]"Not Available“
5. That’s it!! Note that if there are any 0’s in your data
they would get displayed as Not Available
How it Works:
 In this case we have specified a number format only
whenever there is a 0, Not Available is displayed. If
a cell has a value other than 0, General Formatting
kicks in.

There are many cool things you can do using Custom Formatting. Click here to know more.
http://TrumpExcel.com
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Excel Tip # 36: Evaluate a formula Step by Step
Yes. You can do this in Excel. You can evaluate your

How to:

formula step by step, which is often the need during
debugging a formula or trying to decode it.

Let me show you a simple formula evaluation. I have 1 in
A1 and 2 in A2. In A3 I have a formula =A1+A2. Now I want
to evaluate this formula
1. Click on Formula Tab.
2. Click on Evaluate Formula (Keyboard Shortcut – Alt
+ TUF).
3. This will open the Evaluate formula dialogue box.
4. In this formula, press evaluate one by one to sift
through the steps.
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Excel Tip # 37: Get a Unique List (2 Methods)
“How do I get a unique list from this data set”. This is one
of the most common queries I get. And it has a very
common and easy answer. I will show you 2 methods to do
this. Suppose you have a data set as shown below and you
want to get a list of unique items.

Method 2 – Advanced Filter Technique
1. Select the data set.
2. Go To Data  Sort and Filter  Advanced (Key
board shortcut – Alt + A + Q). This will open the
advanced filter dialogue box.
3. In the advanced filter dialogue box, select Copy to
another location.
4. Go to Copy to: field bar and select the cell where
you want to copy this unique list.
5. Select Unique Records Only checkbox at the bottom.
6. Click Ok.

Method 1 – Remove Duplicates
1. Select the data set.
2. Go to Data  Remove Duplicates (in Data Tools).
This will open the Remove Duplicates dialogue box.
3. In the Remove Duplicates dialogue box, select the
column in which you want to remove the duplicates.
If your data has headers, select My Data has Header
checkbox.
4. Click OK.

Note: Method 1 (Remove Duplicates option) would alter
the original dataset. If you want it intact, make a copy.
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Excel Tip # 38: Intersect Operator in Excel
Excel has an Intersect Operator that can be used to find

How to:

the intersecting value(s) of two lists/ranges:
Suppose there is a data set as shown below.
1. Now if use =C2:C9 B5:H5 (Note there is a single
space in between the ranges, which is also the
intersect operator), it will give you 45 (the value in
cell C5), which is the intersection of these 2 ranges.

Click here to see a practical example on how to use Intersect Operator.
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Excel Tip # 39: Join Contents in 2 or more Cells – Concatenate
In excel you can join the content of various cells. For

Method 1 – CONCATENATE Formula

example, suppose you import a list which has First Name in
one column and Last Name in second, and you want to
combine these to be displayed together (as shown in the
pic below).
Here are two ways to do this in Excel (take your pick)

 Go to cell C1 and type the formula
o =CONCATENATE(A1," ",B1)
Note that I have used “ “ (space in double quotes) in
between A1 and B1. If you don’t use it, you will get
TrumpExcel as the output
Method 2 – Using Ampersand (&)
 Go to C1 and type the formula
o =A1&" "&B1
This formula works exactly like the concatenate method.
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Excel Tip # 40: Debug Formula using F9
It’s frustrating when you write a long formula and get an

How to:

error at the end. Spotting an error in a formula could be a
1. Go to the cell which has the formula

pain.

2. Enter into edit mode (press F2)
This technique will help you revisit the formula and
identify the part that is causing the error.

3. Select the entire formula and press F9 – this will
give you the result of the entire formula
 You can also select a sub part of the formula
and do this (see illustration below)

Caution: Do not press Enter after pressing F9. This would hardcode the value and you would lose the formula. A
good practice is to select the part of formula you want to debug, press F9 (note the result), and then press
Control + Z.
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Excel Tip # 41: Handle Errors in Excel Formula
Errors are not bad, we should just know how to handle it.

For Excel 2003

Sometimes errors are the inbuilt factor in your formula

Life isn’t so easy with Excel 2003, as it does not have the

construct (for example, suppose you are using a VLOOKUP

IFERROR function, but there is a way around. You can use

and it is unable to find a value, then it returns the #N/A

a slightly longer version of the same formula.

error).
Here it is:
Here is a method that can handle that error for you:
=IF(ISERROR(VLOOKUP(A1,B1:B10,1,False)),”Not in
For Excel 2007 and above

List”, VLOOKUP (A1,B1:B10,1,False))

MS Excel team added a new formula in Excel 2007 – the
IFERROR function
 Syntax - IFERROR(value, value_if_error)
Suppose you have a VLOOKUP formula
=VLOOKUP(A1,B1:B10,1,False) and it returns an error (as
the value in A1 is not there in B1:B10). You want to display
‘Not in the List’ instead of the ugly #N/A. Here is the
formula you should use
=IFERROR(VLOOKUP(A1,B1:B10,1,False,”Not in List”))
Instead of “Not in List”, you can use any other text, 0, or
blank (“”) if you want.
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Excel Tip # 42: Work with Imported Data – Some useful Tips
There are some issues that most of us face when we

#2 – Separate Text using Text-to-Column

import a list in Excel. Here are some tips that might be
helpful in getting the data in a usable format:

This is a useful functionality if the text is imported in a
single cell and you want to separate it to different cells.

#1 – Change the Case of Text

For example, you may get a list
US,Canada,India,Brazil,China in a single cell and you wish

1. To convert all text into UPPER CASE – Use Upper(A1)

to separate these in different cells

formula. This will change trump excel to TRUMP
EXCEL
2. To convert text into Proper Case (first alphabet of

1. Go to Data  Text to Column.
2. In the Dialogue box (step 1 of the wizard), select

every word is capitalize) - Use Proper(A1) formula.

Delimit (this uses a specified Delimiter to separate

This will change trump excel to Trump Excel

texts).

3. To eliminate unwanted spaces – Use Trim(A1). This
will remove all the spaces except single spaces
between words.

3. Click Next.
4. In the step 2 of the wizard, select the delimiter
(such as a comma, dot, space, dash, etc.). In this
case it is a comma(,). You can specify your own
delimiter depending on your data.
5. Click Next.
6. In the step 3 of the wizard, you can specify the
format of each column that will be created. Then
click on Finish.
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Excel Tip # 43: Count Non-blank Cells
If you are thinking that Excel already has an in-built
function to do exactly this, then you are absolutely right.
This can be done using the CountA() function.
There is only one small problem. A lot of times when you
import data or use other people’s worksheet, you will
notice that there are cells that appear empty while they
are not. They are blank but have =”” in it.
The trouble is that CountA does not consider this as an
empty cell (it counts it as text). See the example below.
Try using =CountA(A1:A11) here. It will give you 11 instead
of 10. The reason is, it doesn’t consider A11 as empty
(while it should, because it is). But that is how excel
works.
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How to:
Here is the fix – use wildcard characters:
=CountA(A1:A11) + Countif(A1:A11,”?*”)
This formula tells excel to count only if the cell either has
a number or atleast one text character. In the ?* combo, ?
(question mark) ensures that at least one character is
present, and * (asterisk) makes room for any number of
additional characters.
Similarly, you can use wildcards in many other formula
such as IF(), Sumif(), Averageif(), and Match().
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Excel Tip # 44: Enable Fill Handle to auto-complete lists
One day, suddenly, my fill handle feature got disabled.

How to:

And to be honest, I had no clue what had happened. I did
not even know that I could enable it in seconds. So I kept
going for months before discovering the way to enable it.
Stupid me!!

1. Go to File –> Options.
2. Select Advanced from the left pane in the dialogue
box.
3. In the Editing Options section, ensure that you have

In this tip I will let you know how enable it

the Enable fill handle and cell drag-anddrop option checked.
4. Click OK.
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Excel Tip # 45: Create a Scrollable List in Excel
A scrollable list is what you need when you have huge data
sets and you don’t want it to hijack your entire screen’s
real estate.

How to:
1. The first step is to get your data. For the purpose of
this post, I have used census 2001 data of 28 Indian
States with its Area and Population.
2. Now Go to Developer Tab –> Insert –> Scroll Bar
(Form Control)
3. Click on Scroll Bar (Form Control) button and click
anywhere on your worksheet. This will insert a
Scroll Bar in the worksheet.
4. Right click on the Scroll Bar and click on ‘Format
Control’. This will open a Format Control dialogue
box
5. In Format Control dialogue box go to ‘Control’ tab,
and make the settings as shown in the pic below. L3
is the cell that is linked to the scroll bar, and its
value varies from 1 to 19. This is the cell value that
we use to make the scrollable list.
6. Resize the Scroll Bar so that it fits at the side of 10
columns (this is just to give it a good look, as shown
in the pic earlier)
7. Now enter the following formula in the first cell
(H4) and then drag it to fill all the other cells
=OFFSET(C3,$L$3,0)

Click here to download the data set and experiment with these formulas.
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Excel Tip # 46: Get Camera Tool in Excel
This one is for all the photography enthusiasts. Yes, excel
has its own camera and its pretty amazing.
By default, you would not have camera tool activated and
visible in the excel ribbon/menu. You can enable it by
using the following steps:
How to Enable Camera Tool
1. Go to File.
2. Select Options  Quick Access Toolbar 
Command Not in the Ribbon from the drop down.
3. Select Camera Tool.
4. Click Add.
5. Click OK.
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How it works
1. Select the data for which you want to create an
image.
2. Click on the the camera tool icon.
3. Press anywhere in the sheet and it will create the
image.
 By default, it adds a border to the image. You
can remove this right-clicking and then going
into Format Picture options.
Some Examples where Camera Tool could be Helpful
1. While creating pictures of dynamic charts that
update on selection.
2. When working with dependent data in multiple
sheets. You could take a picture of the cell, and see
how it changes when you change its dependent cell.

Excel The Smart Way (51 Tips)

52

Excel Tip # 47: Custom design in the bars of a charts
You can customize the way the bars look in a bar chart in

How to:

Excel. I have seen this trick being used by a lot of business
articles by reputed newspapers and websites.

1. Create a bar chart as usual.
2. Right-click on any of the bars and select Format

If used sparingly, this could add a bit of glamour and

Data Series.

context to your charts. Look at the example below (this

3. In the Format Data Series dialogue box, select Fill.

example is a complete figment of my imagination, but I

4. In Fill category, select Picture or texture fill.

hope it does a good job in demonstrating what I mean).

5. Select Insert from File.
6. Select the picture you want to display and Click
Insert.
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Excel Tip # 48: Get the Developer Tab Displayed in Excel Ribbon
Developer Tab is the part that enables you to create cool

How to:

scroll bars and check boxes. But it is not displayed by
default in excel. Here are the steps using which you can
enable the developer tab to get displayed in the ribbon.

1. Go to File.
2. Click Options.
3. In Excel Options dialogue box, click Customize
Ribbon.
4. On the right side panel, In the Main Tabs section,
check the Developer option.
5. Click ok (Now you will have ‘Developer’ displayed
as one of the tabs).
To get the developer tab in Excel 2007 Go to Options –>
Popular –> Show Developer tab in the Ribbon.
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Excel Tip # 49: Reference to an area in a Worksheet
You can create a reference to an entire area in a

How to:

worksheet. This is a good way when you have various
tables in your data and you want to give a link to direct
the user to a particular table.

1. Go to the cell where you want to create the
reference link.
2. Right click and select Hyperlink.
3. In the Insert Hyperlink Dialogue box, select Place in
this Document.
4. In the right-side pane, select the Sheet and type the
cell reference.
Now when you click on the cell, it will take you to the
sheet area that you referenced
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Excel Tip # 50: Display Columns Headers as Numbers (instead of
alphabets)
You can change the columns headers from alphabets to

How to:

number. You may want this when you either work with
R1C1 reference style or you work with macros where most
of the time the column is also reference by its number (for
example in Offset formula).

1. Go to File  Options.
2. In the Excel Options dialogue box, select Formulas.
3. In the Working with formulas category, select R1 C1
reference style checkbox.
4. Now check your worksheet. The column headers
would have changed.
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Excel Tip # 51: Create your own Calculated Field in Pivot Tables
Pivot table is a great way to summarize data. And it also
enables you to play with the summarized data by adding
your own field with your own calculation. For example,
you may want to add 10% to the targets for each region.
Here is how you can do it
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How to:
1. Select the Pivot Table.
2. Go to Pivot Table Tools  Options  Fields, Items,
& Sets. (In Excel 2013/2016, this is in the Analyze
tab).
3. Select Calculated Fields.
4. In the Insert Calculated Field dialogue box
 Name Field: Type the name that you want to
appear. In this case I selected Updated
Target
 Formula: Type the formula. In this case I
used =Target*1.1
5. Click Ok.
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Some Additional Excel Resources


70+ Excel Functions (with examples and videos)



Free Excel Templates



Excel Course (Basic to Advanced)



Excel Dashboard Course



Excel VBA Course



Free Excel Tutorials
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Hey there,
My name is Sumit Bansal and I started TrumpExcel.com as an effort to learn and share amazing
things about Microsoft Excel. It’s a journey, where I aim for continuous learning, and at the
same time, take you all with me.
In this Ebook, I share 51 Excel Tips that you can start using today and be more productive in
your work.
For more such tips and tricks, visit my blog – http://TrumpExcel.com
Feel free to email a copy to friends, share this, print this, and refer to these tips in your blogs. You are NOT
allowed to edit or sell this e-guide. Only I have that Exclusive right.
In case you wish to sell this or plan to customize/commercialize it, get in touch with me at
sumitbansal@trumpexcel.com
Cheers
Sumit Bansal
Excel MVP

Disclaimer: I have tested these tips on Excel 2007, 2010, 2013, and 2016. I have NOT tested these on Excel 2003. All the snapshots
in this e-book are from Excel 2010/2016.
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